
• Management Directive 715 (MD-715) requires government agencies to report gender, ethnicity, race, and disability data to the Equal
Employment Opportunity Commission (EEOC) every fiscal year.

• The structure and data requirements of the MD-715 report are based on EEOC standards.
• The A Series MD-715 reports on gender, ethnicity, and race and the B Series MD-715 reports on disability data.
• Users can run the MD-715 report in Insight, export to Excel, and generate an XML output from the Excel.
• The Excel export includes several conversion mechanisms to modify data to accommodate Agency-specific requirements.

What is the MD-715 report?

Insight Quick Reference | MD-715 Report

Run the MD-715 Report in Insight
1. Click the Catalog action link from the top navigation bar.

8. Click Open in the pop-up box at the bottom of the screen.

5. Select values for the Year, Department, and Agency report
prompts.

Note: Users are encouraged to run the MD-715 for a single department or single 
agency at a time. Running the report for multiple selections has had inconsistent 
results in the past. Please contact the NFC Contact Center for more information.

6. Click Apply.

2. Expand the following
folders:

Shared Folders >> 
Common Report Library >> 
Regulatory Reports.

3. Click the Open action link
for the MD-715 Dashboard.

7. Click the Excel export
icon on the right hand
side of the page.

4. Select either the A or B series tab to
run the respective report.

Note: If a user selects an organization level for which there is no data, the 
organization will not appear in the header of the Excel export.
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Use the MD-715 Report in Excel
Open the MD-715 Report
The report opens to the first tab of a Microsoft Excel workbook, which includes the Report 
Filters and the Table of Contents page. Click Enable Editing below the Excel ribbon to use 
the report. 

Click a report or its corresponding tab at the bottom of the workbook to navigate between tables. 
There are fourteen tables in each MD-715 Series report, containing data about gender, ethnicity, 
race, and disability based on EEOC requirements.  
Note: See page 3-4 of this QRG for a complete list of tables. 

Adjust Formula Settings

The first time you run an MD-715 report, it is necessary to adjust the 
formula calculation settings: File >> Options >>  Formulas, then check 
“Enable Iterative Calculations,” and set maximum iterations to 500.  

The MD-715 report is composed of several tabs, including:
• Home Page tab: Contains the Table of Contents and lists Report Filters applied to the report
• Conversion Mechanism tab: Contains global and table-specific conversions for users to modify
• A1-A14: Contains tables with gender, ethnicity, race, and disability data required by EEOC.

Use the Conversion Tab

It is critical to review the Conversion Mechanism tab before using the MD-715 report. 
The conversion mechanisms default to the most commonly used values, but users 
can modify the conversions to meet Agency-specific requirements. There are both 
global conversions and table-specific conversions. 

Note: See pages 5-6 of this QRG for instructions to modify these conversions. 

View MD-715 Excel Tabs
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MD-715 A Series Tables
The A series tables include data about gender, race, and ethnicity, including certain data and certain conversions: 
• Each table contains data on permanent, temporary, and / or non-appropriated employees.
• Each table calculates percentages either across rows or down columns.
• Some tables utilize a conversion mechanism (See Slide 5-6 for descriptions), as indicated in bold in the table below.

A Series MD-715 Tables

A1: Total Workforce - Distribution by Race/Ethnicity and Sex (Permanent, Temporary, A8: New Hires by Type of Appointment - Distribution by Race/Ethnicity and Sex
Non-Appropriated) • Permanent, Temporary, and Non-Appropriated
• Permanent, Temporary, and Non-Appropriated

A2: Total Workforce by Component - Distribution by Race/Ethnicity and Sex A9: Selections for Internal Competitive Promotions for Major Occupations by 
• Permanent Race/Ethnicity and Sex

• Permanent

A3: Occupational Categories - Distribution by Race/Ethnicity and Sex A10: Non-Competitive Promotions – Time in Grade - Distribution by Race/Ethnicity and 
• A3-1 Permanent: Percentages calculated across the row Sex
• A3-2 Permanent: Percentages calculated down the column • Permanent
Conversion Mechanism: Occupational Category Conversion

A4: Participation Rates for General Schedule (GS) Grades by Race/Ethnicity and Sex A11: Internal Selections for Senior Level Positions (GS 13/14, GS 15, and SES) by 
• A4-1 Permanent: Percentages calculated across the row Race/Ethnicity and Sex
• A4-1 Temporary: Percentages calculated across the row • Permanent
• A4-2 Permanent: Percentages calculated down the column
• A4-2 Temporary: Percentages calculated down the column
Conversion Mechanism: General Schedule Conversion

A5: Participation Rates for Wage Grades by Race/Ethnicity and Sex A12: Participation in Career Development - Distribution by Race/Ethnicity and Sex
• A5-1 Permanent: Percentages calculated across the row • Permanent
• A5-1 Temporary: Percentages calculated across the row
• A5-2 Permanent: Percentages calculated down the column
• A5-2 Permanent: Percentages calculated down the column
Conversion Mechanism: Wage Grade Conversion

A6: Participation Rates for Major Occupations - Distribution by Race/Ethnicity and Sex A13: Employee Recognition and Awards - Distribution by Race/Ethnicity and Sex
• A6 Permanent • Permanent
• A6 Temporary Conversion Mechanism: Quality Step Increases (QSI) Conversion
Conversion Mechanism: Occupational Series Conversion

A7: Applicants and Hires for Major Occupations by Race/Ethnicity and Sex A14: Separations by Type of Separation - Distribution by Race/Ethnicity and Sex
• A7 Permanent • Permanent
• A7 Temporary Conversion Mechanism: Separation NOA Conversion
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MD-715 B Series Tables
The B series tables include data about disability, including certain data and certain conversions: 
• Each table contains data on permanent, temporary, and / or non-appropriated employees.
• Each table calculates percentage either across rows or down columns.
• Some tables utilize a conversion mechanism (See Slide 5-6 for descriptions), as indicated in bold in the table below.

B Series MD-715 Tables

B1: Total Workforce - Distribution by Disability (OPM Form 256 Self-Identification Codes) B8: New Hires by Type of Appointment - Distribution by Disability
• Permanent, Temporary, and Non-Appropriated • Permanent, Temporary, and Non-Appropriated

B2: Total Workforce by Component - Distribution by Disability (OPM Form 256 Self- B9: Selections for Internal Competitive Promotions for Major Occupations by Disability
Identification Codes) • Permanent
• Permanent

B3: Occupational Categories - Distribution by Disability Employees B10: Non-Competitive Promotions - Time in Grade by Disability
• B3-1: Permanent, Percentages calculated across the row • Permanent
• B3-2: Permanent, Percentages calculated down the column
Conversion Mechanism: Occupational Category Conversion

B4: Participation Rates for General Schedule (GS) Grades by Disability B11: Internal Selections for Senior Level (GS 13/14, GS 15, SES) Positions by Disability
• B4-1 Permanent: Percentages calculated across the row • Permanent
• B4-1 Temporary: Percentages calculated across the row
• B4-2 Permanent: Percentages calculated down the column
• B4-2 Temporary: Percentages calculated down the column
Conversion Mechanism: General Schedule Conversion

B5: Participation Rates for Wage Grades by Disability B12: Participation in Career Development - Distribution by Disability
• B5-1 Permanent: Percentages calculated across the row • Permanent
• B5-1 Temporary: Percentages calculated across the row
• B5-2 Permanent: Percentages calculated down the column
• B5-2 Permanent: Percentages calculated down the column
Conversion Mechanism: Wage Grade Conversion

B6: Participation Rates for Major Occupations - Distribution by Disability B13: Employee Recognition and Awards - Distribution by Disability
• B6 Permanent • Permanent
• B6 Temporary Conversion Mechanism: Quality Step Increases (QSI) Conversion
Conversion Mechanism: Occupational Series Conversion

B7: Applications and Hires by Disability (Permanent) B14: Separations by Type of Separation- Distribution by Disability
• B7 Permanent • Permanent
• B7 Temporary Conversion Mechanism: Separation NOA Conversion

Note: Insight does not currently contain data for table B7 because the data is from outside PPS. Please use this table as a template. 4



MD-715 General Conversion Mechanisms
Race and Ethnicity Conversion (A Series Only) 

The Race and Ethnicity Conversion allows the user to specify the race for 
an individual that has two or more races. The default for this individual is 
“Two or more races”. If “Custom” is selected from the drop-down  - you 
can select one of the two races, or “Two or more races.”

Note: See page 7 of this QRG for the RNO to ERI conversion.

Permanent vs. Temporary vs. Indefinite Conversion (A and B 
Series)
The Permanent / Temporary / Non-Appropriated Conversion allows the 
user to define these terms by Type of Appointment and Type of 
Employment based on Agency requirements. Select Permanent, 
Temporary, or Non-Appropriated from the drop-downs in column H.

Disability Conversion (B Series Only)
The Disability Conversion allows the user to modify the conversion from 
old to new disability codes. The default is to convert old disability codes to 
new codes based on OPM guidelines from the SF-256 and the HR Data 
Standards Guide. Select a new Disability Status for each Disability Code 
from the drop-downs. 

Organization Level Conversion (A and B Series)
The Organization Level Conversion 
allows the user to specify the 
Organization Level used to run the 
MD-715 report in Insight. The default 
Organization level is Agency, but 
users can select the Organization 
Level from the drop-down to indicate 
a more specific Organization level.

Note: This setting is critical to returning 
accurate results. Please verify the 
Organization Level Conversion before 
using the MD-715 report. 
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MD-715 Table-Specific Conversion Mechanisms

The Occupational Category Conversion allows the user to modify the 
categories based on Position Supervisory status, which are defined by 
EEOC here. If an employee has a Position Supervisory status of 2 or 4, 
the Occupational Category is 1. Position Supervisory Type 2 will default 
to the “Other” grouping for section 1 of this table. Position Supervisory 
code of 1 defaults to the “Executive/Mid-Level/First-Level” grouping. 
Type an Occupational Category and select a grouping based on Agency 
requirements. 

Executive Pay Plan Conversion (A3, A4, B3, B4)
The Executive Pay Plan Conversion allows the user 
to specify their executive pay plans  for their 
organization by typing appropriate pay plan codes. 

General Schedule (GS) Conversion 
(A4-1, A4-2, B4-1, B4-2)

The GS Conversion allows the 
user to convert non-GS pay bands 
to the GS schedule. Type the 
Agency-specific Pay Plan and 
Grade in the equivalent GS pay 
band.

Wage Grade (WG) Conversion 
(A5-1, A5-2, B5-1, B5-2)

The WG Conversion allows the 
user to convert non-WG pay 
bands to the WG schedule. Type 
the Agency-specific Pay Plan and 
Grade in the equivalent WG pay 
band.

Occupational Series Conversion (A6, B6)
The Occupational Series Conversion allows 
the user to select whether to include the top 
seven Occupational Series by Employee Count 
or seven user-specified mission critical 
Occupational Series. There is a separate 
conversion for permanent or temporary 
employees. To set mission critical 
Occupational Series, select Mission Critical
from the drop-down and type 1-7 next to 
each to order the Occupational Series.

New Hires Conversion 
(A8, B8)
The New Hires Conversion 
allows the user to enter the 
Nature of Action codes used by 
their specific agency for new 
hires. The default will be set to 
100 series NOA codes. Type 
any additional NOA codes used 
by your agency.

Quality Step Increases (QSI) Conversion (A13, B13)
The QSI Conversion allows the user 
to choose whether QSI is calculated 
using Base Contract or Scheduled 
Salary. The default is Base Contract 
Salary. QSI is the difference 
between salaries after a within 
grade increase that is off schedule 
(892 NOA). Select an option from 
the drop-down. 

Note: Some award types may be “N/A.” 
This is because they are cash awards 
under $100, and the MD-715 only asks for 
cash awards greater than $100.

Separation NOA Conversion (A14, B14)
The Separation NOA Conversion 
allows the user to modify the 
separation type for each NOA code. 
Select a separation type from the 
drop-down. 

Occupational Category Conversion (A3-1, A3-2, B3-1, B3-2)
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Appendix

Note: You can access the raw data reports that feed the MD-715 report in 
the Insight Public Folder. Expand the following folders Shared Folders >> 
Public >> MD-715 Raw Data >> A Series or B Series. 

Generate XML for the MD-715 Report

Generate XML for the MD-715 
report to deliver the data to EEOC. 
1. Click the Developer tab in

the Excel ribbon.
2. Click Export in the XML

section.
3. Save the file.

View Raw Data Used in Each Table

To view the data used to calculate the values in the MD-715, view the 
raw data tabs. By default, the raw data tabs are hidden. To access the 
raw data tabs: 

1. Right click any tab at the bottom of the Excel sheet.
2. Select Unhide.
3. Select a raw data tab from the Unhide window.
4. Click OK.

Certain columns are Insight generated and others are calculated in Excel. To 
protect PII, raw data is broken down by groupings based on Employee 
Count instead of by employee.

RNO to ERI Code Conversion
If RNO equals…

Hispanic or Latino
D - Hispanic
Y - Not Hispanic in Puerto Rico
American Indian or Alaskan Native

Then ERI equals…

100000
000000

A - American Indian or Alaskan Native 010000
Asian
F - Asian Indian 001000
G - Chinese 001000
H - Filipino
L - Japanese
M - Korean

001000
001000
001000

P - Vietnamese 001000
Q - All Other Asian or Pacific Islanders 001000
B - Asian or Pacific Islander 001000
Black or African American
C - Black, Not of Hispanic Origin
Native Hawaiian or Other Pacific Islander

000100

J - Guamanian 000010
K - Hawaiian 000010
N - Samoan 000010
White
E - White, Not of Hispanic Origin 000001
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Optional: Add the Excel Developer Tab

To generate an XML output, add the Developer tab to the Excel 
workbook: 
1. Click File.
2. Click Options.
3. Select Customize Ribbon.
4. Select Main Tabs from the Customize the Ribbon drop-down.
5. Click the Developer check box.
6. Click OK.

https://insight.edc.usda.gov/analytics/saw.dll?catalog


Appendix
Printing the MD-715 Report

To ensure clean printing of the full MD-715 report, it is helpful to 
adjust certain Excel settings. To set the print scaling: 

1. Navigate to Table 2 and
select all cells containing
data to be printed

2. On the upper tabs of the
workbook, click: Page
Layout >> Page Setup >>
Print Area >> Set Print Area

3. Hide the Conversion
Mechanism tab by right-
clicking it and selecting
“Hide”

4. Navigate to File >> Print
in the top left corner of the
Excel output.

5. In the Settings list, select
the first drop-down menu
to adjust the page scaling,
and choose Print Entire
Workbook.

Note: To print a single sheet, 
navigate to the tab you’d like to 
print, then under this Print Settings 
menu select “Print Active Sheets.” 

6. Click Print.

Adjusting the Error Default Display Preferences

In some versions of Excel, the default is set to display cell errors in 
a green font. Users can adjust this preference to display or hide 
the errors throughout the report.

To display or hide these errors throughout the report:

1. Navigate to File >> Options.

2. Select the Formulas menu.

3. Under the Error Checking section, select or deselect the
“Enable background error checking” box.

4. Click OK.
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